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Operating System!?

* Software Program—-Similar in this Sense
to Other Programs

» Resource Encapsulation—Lens through
which Users and Applications View
System Resources like Hard disk, DVD
drives, Networks.
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- Operating System!?
U

Operating System is Essential

* Binds Hardware and Software Together
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Symbian OS—Overview

* Designed with
Smartphones as the Target
Platform in Mind

* Multitasking and
Multithreading Supported

» Symbian OS Kernel is
Microkernel

* Mobile Phone
Manufacturers Buy
Licenses of Symbian
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Symbian OS—Layered Model

e Symbian OS is Structured in Layers

¢ Layers are Decomposed in Blocks and Sub-
blocks

* Blocks and Sub-blocks are Decomposed in
Components or Collection of Components

* Layers are Highest Level of Abstractions

» Components are Lowest Level of
Abstractions

* Layers and Blocks are Logical Concepts

e Components are Physical Objects (Software
Code) N

PAN

Localization

Symbian OS—Layered Model

e Layers

> Each layer abstracts the functionality of the layer beneath and provides
services to the layer above
o Examples
OS Services Layer
Ul Framework Layer

e Blocks
> A block or sub-block roughly corresponds to a “Technology Domain”
> Examples:
Telephony Services
Network Services
¢ Components
o Components are the basic entities of the model

> Common, Optional and Replaceable functionality is defined at
Component Level
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Symbian OS—Layered Model

» Symbian OS is Shipped in Headless Configuration
\ o Minimal User Interface
> Not Production Quality User Interface
¢ Mobile Phone Manufacturers Either
> Develop their Own Production Quality User Interface or
o License a Suitable User Interface
* Production Quality User Interfaces Already Developed:
° S60 (Series 60)—Developed and Licensed by Nokia
o UlQ—Developed and Licensed by UIQ Technology

° MOAP (Mobile Oriented Application Platform)—Developed by
FOMA (Freedom of Mobile Access) Consortium in Japan

o Series 80 and 90—Developed by Nokia but not Licensed to
Others

PAN

Localization

Symbian OS—Layered Architecture

Ul Framework Layer

Uikon FEP Base

eneric OY
Services

Communication Services ultimedia L
. onnecthlty
Telephony ) (Short Link Eetworkin% & Graphics Servi
Services Services Services Services ervices
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Symbian Layers

e Ul Framework Layer
» Application Services Layer
» OS Services Layer

 Base Services Layer

e Kernel Services & Hardware Interface
Layer

(Book: Pg 14-15)
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Symbian OS—Key Design Patterns

Localization Of Mobile Platforms : Pg 15
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References
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Symbian: Application Design and

" Architecture

(S60 Perspective)

PAN
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Application Design: Typically MVC
Pattern

* ModelView Controller Architecture
® Model (the Document—CEikDocument)
Contains and Manipulates Data of the Application
® View (Application View—CCoeControl)
Displays Application State Based on Model Data

Receives User Input
Notifies Controller of Relevant Events

¢ Controller (Application Ul Controller—

CEikAppUl)
Handles Application Events
Interacts with Model \S’r/ o
Selects the View to be Displaye%%» F/a\// S Z@
Pt PAN

Localization

Symbian Application Framework
¢ UIKON (Previously Called EIKON)

> Main Component of “Application Framework”
> Allows other GUI Frameworks to Run on Top of
Symbian OS
S60
uiQ
e UIKON (Sub)Frameworks

> CONE (Control Environment)

Framework for Graphical User Interface

> APPARC (Application Architecture)

Framework for Applications and Appllcatlon Data Of\\b’f/p}'O
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S60 and UIQ Platforms

» Extend the UIKON Framework by Adding
Libraries Appropriate for each of Them

» S60 Library: Avkon (Class Prefix: CAkn)
» UIQ Library: Qikon (Class Prefix: CQik)
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Localization
Application Components
» Application
e Document
* AppUl
* View
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Application Structure Overview in
S60

AknViewApp
AknApplicatio CAknAppUi f| CAknView

AknAppUiBasg¢

CCoeControl
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Application Entry Point

 Every Symbian Application must
Implement Two Functions that are Called
by the Framework to Launch the
Application

LOCAL_C CApaApplication* NewApplication()
{

return new CMyApplication;
}
GLDEF_C TInt E32Main()

{
return EikStart::RunApplication( NewApplication );
} 9
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Resources

e Resource Files are Used to Define:

> User Interface Components
> Visible Text

Localization
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Resource Files

* Resource Files Contain:
> GUI Element Definitions (Menus, Dialogs etc.)
> Strings Needed by Application at Runtime

* Advantages
> Make Source Code Shorter and Simpler

> Save Memory because Text is Loaded only
when Needed

> Make Localization to Different Languages

. %,
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PAN
Localization
Resource File Structure
e Data Types
> BYTE,WORD(2-bytes), LONG(4-bytes),
DOUBLE(8-bytes)
o LTEXT(A Unicode String with Defined
Length)
> BUF (A Unicode String)
o LINK, LLINK(ID of Another Resource)
PAN

Localization
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Resource File Structure

- o Resource File Statement Types
> NAME

> STRUCT: Named Structure for Building
Aggregate Resources

o RESOURCE: Defines a Resource

> ENUM/enum: Defines an Enumeration (Similar
to C)

PA

Localization

Resource File Structure

-« STRUCT Statment

o STRUCT Statements are Placed in Files with
.rh (Resource Header) Extension

Multi-page

STRUCT DIALOG il /,.aa Profiles —  tabs

{ General
LONG flags=0; i
LTEXT title=""; Dialog i
LLINK pages=0; = Ringing type
LLINK buttons=0;  EETTTTRES ——— oo
STRUCT items[]; // an array [ Ll ALY
LLINK form:O; e o | -
Options Backv—___ Smkey)a)_-
- - ¥ v /;)/ 3 \(“/9
CIOADR.
;Y 4 PA

Localization
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- Resource File Structure
]

« RESOURCE Statement

RESOURCE DIALOG r messages_dialog
{
title = "Title text";
flags = EAknDialogSelectionList;
buttons = R_AVKON_SOFTKEYS_OK_CANCEL;
items =

DLG_LINE
{

type = EAKnCtSingleListBox;

id = EListControl;
control = LISTBOX

flags = EAknListBoxSelectionList;
array_id = r_message_list;

Localization

~ Resource Files: Bitmaps and Icons
J

» Application Icons are Stored in Bitmaps

¢ In Symbian, Multiple Bitmap Files are
Stored in a Single File Called Multi Bitmap

 Bitmap Resources are Structure in
Following Two Files
> MBM (Multi Bitmap File)

> MBG (Contains an ID for Each Bitmap in
MBM)

PAN

Localization
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Registration

» Applications are Required to be
Registered with Underlying Platform
* File : <application_name>_reg.rss
Contains Registration Information
> UID of the Application

> Name of Application Executable (without
extension)

> Application Properties (embedibility, hidden)
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Localization

¢ Localization Files Contain “Local Language
Strings”

e One Localization File is Produced for
Each Language

* File : <application_name>.rls Contains
Strings to be Localized
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TARGET
TARGETTYPE
uiD
OxE3AA6613
SOURCEPATH
SOURCE
SOURCE
SOURCE
SOURCE

SOURCEPATH

START RESOURCE
HEADER
TARGETPATH
END //RESOURCE

START RESOURCE
TARGETPATH
END //RESOURCE

MyApp.exe
exe

0x0100039CE

\sre
MyApplication.cpp
MyAppView.cpp
MyAppUi.cpp
MyDocument.cpp

.\data

My.rss

resource\apps

My_reg.rss
\private\10003a3f\apps

USERINCLUDE
SYSTEMINCLUDE
LIBRARY
LIBRARY
LIBRARY
LIBRARY
LIBRARY

LANG

VENDORID
SECUREID
CAPABILITY

Project Specification File (MMP)

.inc
\epoc32\include
euser.lib
apparc.lib
cone.lib
eikcore.lib
avkon.lib

ol

(0

OxEA7408AF
ReadUserData

START BITMAP MyApp.mbm

HEADER
TARGETPATH
SOURCEPATH

SOURCE <24

SOURCE 8
END

\Resources\Apps
.\images
image|.bmp
images2.bmp

Project Specification File

* UID Comprises 3 Components:

> UIDI:Same for All Binary Files and Automatically
Supplied

> UID2: Indicates the Type of Executable
(0x0100039CE for Applications)

> UID3: Uniquely Identifies the Application
» SECUREID
> By Default Same as UID3
o CAPABILITY

o Specifying the APIs that Application want to &

Access
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Application Resource Files

[Fla Narme | Daseripion |

AppName.rss
AppName_reg.rss

AppName.rls or
AppName.loc

AppName.rsg
AppName.hrh
AppName.rsc

Application’s Resource Script
Application’s Registration Information

Application’s Localizable Strings

Generated Header Containing Symbolic Resource IDs
Enumerated Constants for Application’s Commands

Generated Compiled Resource File

o‘-grb
—d %. ; / 'Q‘,‘/g-‘c
p PAN
Localization
~ Application Architecture
- Possibilities
\ |
@
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Traditional Symbian Control Based
Architecture

CCoeControl CCoeAppUi ApaApplicatiof
CEikAppUi EikApplicatio

OOITITTITTITTTIITYT VYITTITTIT Y TINNrnnayy

AknAppUiBas

CAknAppUi AknApplicatio

Localization

Traditional Symbian Control Based Architecture

(@

¢ Localization of Mobile Platforms (Pg 45)

Localization

2/16/2012
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Dialog Based Architecture

CCoeControl CCoeAppUi ApaApplicatio
[AEikBorderedContr Bt
CEikAppUi EikApplicatio

s CAEikDialog

AknAppU|Ba

CAknDialog CAknAppUi AknApplicatio

CMyDialog CMyAppUi MyApplicatio

Localization

Dialog Based Architecture

(@

* Localization of Mobile Platforms (Pg 45)

Localization

2/16/2012
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View Switching Architecture

CCoeAppUi ApaApplicatiol
CEikAppUi [ICEikDocumentCEikApplicatiol
MCoeView

[aenasanusncndiancncncncncadinencncnnnnnnnsl
AknAppUiBas

CAaniew CAknAppUi AknApplicatio

AknViewApp

Localization
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* Symbian OS C++ for Mobile Phones by Richard
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* Developing Software for Symbian OS by Steve
Babin

* The Accredited Symbian Developer Primer by
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Symbian: Application
" Development Concepts

S~ 4
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Localization

Class Naming Conventions

e Class Names
o Prefix+Class Name+Suffix

e C Classes (C is Prefix in Class Name)
° Prefix ‘C’ Stands for ‘Cleanup’
> Derived Directly or Indirectly from CBase
> Should be Constructed on Heap and Require Cleanup

> Should Not be Constructed on Stack, Use Private/Protected
Constructor to Prevent this

> A Class can Only Inherit from a Single C Class
o Example: CArray

e T Classes (T is Prefix in Class Name)
> Also Called Data Type Classes
> Encapsulates a Value of Specific Type e.g. TChar
> Generally Do Not Use Dynamic Data i.e. Created on Stack but M@P\S}O.

also Use Heap if Require SN2
PifRes ¢ Ay TR
FAE S PAN

Localization
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Class Naming Conventions

¢ R Classes (R is Prefix in Class Name)
> Also Called Resource (‘R’) Classes

~_ 1 > Owns a Client Side Handle to a Resource, Resource is Actually Owned by a
Symbian OS Server

> Can be Instantiated on Heap or Stack
> Example:RFile

e M Classes (M is Prefix in Class Name)
> Also Called Interface Classes
° Equivalent to an Abstract Class (Contains Pure Virtual Functions)
> Used to Define Callback Interfaces
> A Class can Inherit from Multiple M Classes

o Static Classes (No Prefix Attached to Static Classes)
. . . IO
> Contains Only Static Functions SO0,

A . . AN

> Cannot be Instantiated into an Object : 1 G/-)/’-‘ YO
- VL8 6T e g\c
& = PAN

Localization

Symbian Data Types (e32defs.h)
| DataTypes Symbian OS
| |Integer TInt, TInt64,TInt32, TInt16,TInt8
Unsigned TUint, TUint32, TUint1 6, TUint8
Integer
Float TReal, Treal64,Treal32
Character TText, TTextl 6,TText8, TChar
Boolean TBool
void* TAny*, (Can Point to a Function__zg;
Well)
Localization

21



Exception Handling

e Standard C++ Exception Handling in
Symbian OS v9 (try/catch mechanism)

 Exceptions for Previous Symbian OS
(before OS v9) are “Leaves”

> Leaves are Alternative to C++ Exceptions

Q)
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Localization

Exception Handling

» Exceptions or Leaves
> Runtime Errors that are not Programmer’s Fault

> Examples: Lack of Memory, Inability to Open
Network Connection

* Panic
> A Programming Error

> Generally, an Application is Terminated in Case of

Panic
> Panics Cannot be Caught and Handled 80,
> Examples: Out of Bounds Arr;%%} 0 O%’:/\/,\/\ZO
OGRS

Localization
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Exception Handling: Leaves

* A lLeave

o Suspends Code Execution at the Point where Leave Occurs
> Resumes Execution where Leave is “Trapped”

Leaves May Occur while Performing Operations that
May not Succeed

° Allocation of Memory

o File Creation
 Traps are used to Catch Leaves and Allow them to be

Handled
» Functions that May Leave have “L” as Suffix in their
Name
6
AO00,
N
V=
NS
Sa
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Localization

Why Do Leaves Occur!?

e Calling a Leaving Function

» Use of Overloaded new (Eleave)
Operator when Memory Allocation Fails

» Use of Explicit Leave [Similar to C++
Throw]
> User::Leave()
o User::LeavelfError(TInt)

> User::LeaveNoMemory()

N
o User::LeavelfNull() Coesib i P

PAN

Localization
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How Leaves are Trapped!?
e |f a Function may Leave, it is Called Like
This

> TRAPD(error, FunctionMayLeavel());
- OR

o Tint error;

> TRAP(error, FunctionMayLeavel());

-
N
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Localization

Cleanup Stack

 Cleanup Stack is Crucial to Symbian
Memory Management

e Used to Ensure that if a Leave Occurs,
there are No Memory Leaks

» Cleanup Stack is Used to Store Pointers

that may Become Orphaned if a Leave
Occurs

PAN

Localization
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Cleanup Stack Rules

* Any Locally Scoped Pointer to a Heap-
Allocated Object must be Pushed onto
the Cleanup Stack if there is a Risk of a
Leave Occurring and there is no other
Reference to the Object Elsewhere

¢ Instance Data (data owned by an instance

of a class) Must Never be Pushed onto
the Cleanup Stack

Cleanup Stack Functions
* To Push a Pointer on Cleanup Stack
o CleanupStack::PushL(aPointer)
* To Pop a Pointer from Cleanup Stack
o CleanupStack::Pop(aPointer)
* To Pop Multiple Items
o CleanupStack::Pop(aCount,
aPointerTolastExpectedltem)
* To Pop and Destroy
> CleanupStack::PopAndDestroy(aCount, <55
aPointerTolastExpectediten % f \} ’f,f/Q\/t
DAY,
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2-Phase Object Construction

* Object Construction Steps on Heap
o Step- |:Allocate Required Memory on Heap

> Step-2: Execute Constructor of the Allocated
Object

* What if Step-| Succeed, and Step-2 Fails?
> Allocated Memory will be Orphaned

* Solution
> Perform Construction of Complex Objects in
S0
Two Phases %,
7~ NCr AN
\ O‘JQ-\.
©
PAN

Localization

2-Phase Object Construction

e Make All Constructors Private or Protected

* Provide Static Factory Function(s) to Create
Objects in Following Steps:
° Allocate Memory on Heap Using Almost an
Empty Constructor i.e.a Constructor that
Cannot Leave

° Push the Allocated Object Pointer on Cleanup
Stack

o Perform Construction of the Object Data

> Pop the Allocated Object Pointer from Cleanup(\D
Stack X%,

- /\c
?)?§;
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2-Phase Object Construction

e Tips
o Constructors and Destructors Must Never Leave

o Destructors Must Never Assume that
Construction was Done in Full

PAN

Localization

2-Phase Object Construction Mechanism

* new: Almost Never Used. Used when Constructing a New
Instance of an Application

 *» new (ELeave): Used when Constructing a Heap-
Allocated Instance of a Class

> NewL(): Used when Constructing a Heap-Allocated Instance of a
Compound Class [Cleanup from Cleanup Stack is Not Needed]

° Instance is Either Directly Assigned to Member Pointer of
Another Class Object OR

> There is No Danger of a Leave before the Object is Deleted

> NewLC(): Used when Constructing a Heap-Allocated Instance of a
Compound Class [Cleanup from CleanupStack is Needed]

° Instance is Assigned to a Locally Scoped Pointer and there is a
Danger of a Leave before the Object is Deleted

()
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Descriptors

* Descriptors in Symbian OS are Similar to
Strings
* May Contain Text and Binary Data

e TPtr8—8 bit Characters—Narrow
Descriptors

o TPtr16—16 bit Characters—Wide
(Unicode) Descriptors

* Descriptors Can be
> Constant (Contents are Constant)

N9
> Modifiable (Contents are Modlflable) %\\‘\/i’
%% ek } K5
PAN

Localization

Descriptors

* Descriptors have an iLength Member that
Stores the Current Length of the
Descriptor

 Descriptors can Work without Null
Termination

* Modifiable Descriptors also have an
iMaxLength Member

* An Attempt to Increase the Length of the
Descriptor beyond the Maximum Length

will Result in an Immedla%%r}}; J f3>’\<"/s
7 % /Q R
PAN

Localization
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Pointer Descriptors

* Can Point to Text on the Heap, or Stack
e Constant: TPtrC

Pointer

6 | 0x123456-

v
pu
m
-
-

¢ Modifiable: TPtr

HE LILIO!

Max
Lengt
h

v 1) G,/\-)\/ \{:{O
10| 0x23456 ol
7 Loc]:{i\z':iion
Stack Based Buffer Descriptors
» Useful for Relatively Small Size of Data
¢ Directly Contain Data (as Part of Descriptor
Object)
» Constant: TBufC<6>
Length
*6 H/E/L L O|!
* Modifiable:TBuf<8>
: 6 8 H E L L 0 ! O-'\g;(),
4 o
'6%;9
PAN

Max Length

Localization
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» Can be Used for Strings
° That are Too Big to be Placed on Stack

> For Which Size is Not Known at
Compile Time

e Constant: HBufC

Dynamic Descriptors (Heap Based)

Localization

e Modifiable: RBuf

0x23456
7

- - )/
)
Z =Ny

Dynamic Descriptors (Heap Based)

bpo
\\vf’
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String Literals

e Literals are Strings, Generally Used for
Printable Text in the Program

* Literals are of Type TLitC, TLitC8, TLitC16
e String Literals are Constructed using the
_LIT Macro

o _LIT(KText,“Hello World");

> Where KText is Name of String Literal (i.e.
variable name)

PAN

Localization

Collection Classes: Arrays

* RArray
> An Array of Fixed Length Objects

> Size of One Array Element can Not Exceed
640 Bytes

* RPointerArray
> An Array of Object Pointers

PAN

Localization
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Collection Classes: Arrays

e CArray
o Use Buffers to Store Data

° Flat CArray
Store Entire Data in a Single Heap Cell

Once Full, any Append Operation Requires a New
Heap Cell to be Allocated that is Large Enough to
Contain the Original and New Data

+ Segmented CArray
+ Store Data in Doubly Linked List of Smaller Segments
+ Each Segment is a Separate Heap Cell of Fixed Size S,

PAN

Localization

Asynchronous Services

 All System Services are Provided through
Servers

» Servers Operate in their Own Processes

* Service Provider APIs Typically have
Asynchronous and Synchronous Versions of
their Functions

» Service Request Function Returns
Immediately, while the Request itself is
Processed in the Background.

e Relevant Processes are Notified when
Request is Complete <&,
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Asynchronous Services and Active
Objects

» Symbian Allows Application Programs to
Create Threads

* Multiple Asynchronous Services can be
Accessed using Multiple Threads

* However, Symbian Recommendation is to
Use Active Objects where Possible, as an
Alternative Option

PAN

Localization

Active Object Framework

 Active Object Framework
> Active Objects
> Active Scheduler

 Active Object Framework is Used for
Event Driven Multitasking

e Active Scheduler Maintains a List of Active
Objects which have Made Request for an
Asynchronous Service

PAN

Localization
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Active Object

 Implement ‘Asynchronous Service
Requesting Objects’ as an Active Object

e An Active Object:

> Requests an Asynchronous Service and

> Handles the Resulting Completion of Event
Sometime After the Request.

> May Ask to Cancel a Request
o |s Listed with Active Scheduler

)
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Localization

Active Scheduler

* When Asynchronous Service Completes,
It Generates Events to Notify Active
Scheduler

e Active Scheduler

> Detects Service Completion Events
> Determines Associated Active Object
o Calls the Active Object to Handle the Event.

PAN

Localization
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Submitting an Asynchronous Request

» Each Active Object Can Only Have One
Outstanding Request

¢ If a Request has Already been Placed by an
Active Object,a New Request may Result in

> Panic
> Refuse
> Cancel Outstanding Request and Submit New
One
&)
00,
N
S
PAN

Localization

Active Object Event Handling

* Active Object Implements the Event Handling Function

¢ Active Object Event Handler is the Function for
Handling Completion of Asynchronous Call

* Active Object Handler is Not Pre-Empted

e Control Returns to the Active Scheduler When Event
Handler Returns

* If Multiple Requests are Completed, Control Returns to
the Scheduler, they are Handled Sequentially in Order of
their Priority

* Active Scheduler Calls the Event Handling Function of
Associated Object

PAN

Localization
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Active Object Structure: Key
Elements

iStatus: Data Member Representing Request Status.

R-Class Object: A Handle on the Asynchronous
Service Provider (usually an R-class object).

Connection to the Asynchronous Service Provider.
Function to Issue the Asynchronous Request

RunL(): Handler Function to be Invoked by the Active
Scheduler when Request Completes

Cancel(): Function to Cancel an Outstanding Request

;
\

TS

o Y
ST

PAN

Localization

Active Object Implementation

Create a Class Derived from CActive

Create Asynchronous Service Provider Handle (R-Classes
as a Data Member in the Class

Invoke Constructor of CActive, Specifying Object Priority
Connect to the Service Provider in ConstructlL() Method
Invoke CActiveScheduler::Add() in ConstructL()
Implement NewL() and NewLC()

Implement Asynchronous Request Function that Calls the
Service, Specifying iStatus as the Argument.

Call SetActive()

5
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Active Object Implementation

contd..

* Implement RunL() Method to Handle
Necessary Work Once the Request is
Complete

* Implement DoCancel() to Handle Request
Cancel Operation.

¢ Implement RunError() to Handle any Leaves
from RunL().

* Implement the Destructor to Call Cancel()
and close the Handle(s) on the Service
Provider(s).

PAN

Localization

Using Active Object

* Instantiate using NewL() or NewlLC() as
Appropriate

e Call Start(), to Make the Initial Request

* To Cancel the Request Prior to
Completion, Call Cancely().

PAN

Localization
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Active Objects: CActive Structure

-« class CActive : public CBase {
A public:
IMPORT_C virtual ~CActive();
| IMPORT_C void Cancel();
\ | inline TBool IsActive() const;
inline TInt Priority() const;
protected:
IMPORT_C CActive(TInt aPriority);
IMPORT_C void SetActive();

/I Implements cancellation of outstanding request. This function is called as part of the active object's
Cancel().

virtual void DoCancel() =0;

// Handles an active object's request completion event. A derived class must provide an implementatio

handle completed request. The function is called by active scheduler when a request completion event
occurs.
virtual void RunL() =0;

virtual TInt RunError(TInt aError); //Called by Active Scheduler if RunL() Leaves

public:
/IRepresents the status or error code returned by the asynchronous service provider.
TRequestStatus iStatus;
private:
TBool iActive; W&o
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Active Objects: Implemented CFileLoader

class CFileLoader : public CActive
{
public:
void Start();
private:
CFileLoader();
void ConstructL(const TDesC& aFileName);
void RunL();
TInt RunError(TInt aError);
void DoCancel();

private:
TFileName iFileName;
RFile iFile;
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ECOM

* ECOM is a Generic and Extensible Framework
by which Abstract Interfaces can be Defined and
their Implementations Identified, Loaded and
Managed.

* ECOM is A Mechanism to Extend Symbian OS
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ECOM

e What ECOM Does?

o ldentification: Identifies all the Concrete
Implementations of an Interface.

> Resolution: Allows the Client to Choose the
Implementation to be Used

o Instantiation: Instantiates an Instance of the
Concrete Class which Implements that
Interface
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ECOM (EPOC Component Obiject
Model)

. » ECOM Architecture is Used Transparently by
Clients

* ECOM Server Manages Requests to

o ECOM Server Maintains a Registry of Al
Interface Implementations Installed on Device
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Instantiate Concrete Instances of an Interface.

ECOM Plug-in Interface

Characteristics
e Standard Definition Functions

o Abstract Class that Defines a Set of One or
More PureVirtual Functions

> Concrete Classes Implement these Virtual
Functions

* | or More Factory Functions

> Used to Allow Clients to Instantiate an
Interface Implementation Object

 Release Function
> Used to Delete / Release Plugin
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